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1. Introduction
Un tableur est un logiciel informatique permettant d’effectuer des calculs plus ou moins 
complexes de façon automatisée, de gérer les données et de les interpréter graphiquement.

A l’origine les tableurs étaient principalement utilisés pour traiter des données financières, 
mais les nombreuses fonctionnalités de ces logiciels, ainsi que leurs facilités d’utilisation ont 
permis à chacun de se les approprier pour une utilité quotidienne. Ils permettent de tenir des 
comptes, de créer et de gérer des données (carnet d’adresses, membres d’association…), de 
résoudre des calculs complexes, et d’interpréter graphiquement des données chiffrées 
(courbes, camemberts...).

2. Découverte de l’interface Calc (classeur, 
barre d’outils, feuille de calculs, cellules,...)

2.1.Interface
Ouvrir Calc

Quel que soit le tableur on y retrouve les mêmes éléments incontournables 

1. La feuille de calculs contient les cellules à l’intersection des lignes et des colonnes -« zone de 
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travail ».
2. La barre de titre, comme dans la plupart des applications, contient le nom de document et 
le nom du logiciel.
3. La barre de menus et la barre d’outils. Cet ensemble est le tableau de bord du logiciel.
4.La barre de calculs sert à insérer des calculs et des formules dans les cellules.
5. Les numéros de colonnes et de lignes, permettent d’identifier les emplacements des cellules 
(B12, R7, …).
6. Les onglets des feuilles donnent la possibilité d’ouvrir plusieurs feuilles de calcul dans un 
même classeur afin d’optimiser l’organisation.
7. Les barres de défilement horizontales et verticales, permettent le déplacement dans la 
feuille de calculs.

2.2.Quelques notions
• Les classeurs : dans l’univers des tableurs, les fichiers s’appellent des classeurs 

(extension .ods). Ils contiennent des feuilles (de calculs). Le nom est visible dans la 
barre de titre (2).

• Les feuilles de calculs : un classeur est composé de plusieurs feuilles de calculs. 
Lorsqu’on ouvre un classeur, le logiciel nous en ouvre automatiquement trois dont 
vous retrouverez les onglets (6) en bas à gauche de votre première feuille. - Ajouter, 
changer le nom, supprimer.

• Les cellules : les cases contenues dans la feuille de calcul (1) s’appellent des cellules. 
Une feuille de calculs en comporte plusieurs millions. Chaque cellule porte le nom qui 
correspond à ses coordonnées. 

• La sélection : vous serez continuellement amené à sélectionner une ou plusieurs cellules
– clique avec le souris pour une cellule, ou bien cliqué-glissé pour une plage des cellule. 
Exemple

• Les formules : dans chaque cellule, il est possible d’insérer des formules afin de faire 
exécuter au logiciel des calculs ou des opérations plus ou moins complexes. Ces 
formules apparaîtront dans la barre de calculs (4). Exemple.

3. Les formats de cellules
Le format d'une cellule est l'ensemble des propriétés d'affichage d'une cellule, lorsque l'on 
applique
un format, on met en forme une cellule, on formate une cellule.
De quoi est composé un format :
– le type de nombre (nombre, date, symbole monétaire...)
– la police de caractère (type de police, taille...)
– les effets de caractères (souligné, barré, couleur de police...)
– l'alignement (alignement vertical, alignement horizontal, orientation...)
– les bordures (couleur, emplacement...)
– l’arrière-plan (couleur de fond)
– la protection de cellule (affichage, modification, impression...)
Toutes ces propriétés d'affichage se retrouvent dans le menu Format > Cellules

3.1.Styles et formatage
Plutôt que de formater une cellule directement, puis une autre а l'identique, et ainsi de suite, il
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est en effet plus pratique et rapide de créer un format de cellule, l'enregistrer dans Styles et 
formatage, puis de l'appliquer aux cellules voulues : ainsi, toute les cellules auront exactement 
le même format, ce qui peut ne pas être vrai lorsque l'on fait du formatage direct.
Comme Styles et formatage va mémoriser tous les formats voulus, cette boite dialogue va 
s'avérer
incontournable pour réaliser du formatage conditionnel.

3.2.Formatage conditionnelle. format selon une valeur
Créer des styles

Sélectionner une plage   Format / Formatage conditionnelle

4. Serie des donnée

4.1.serie numerique 
On obtient un élément en ajoutant un nombre fixe, appelé « incrément » ou « pas », à l’élément 
précédent. Choisir le pas.
1 3 5        25 30 35

4.2.serie chronologique 
Les valeurs d’une série chronologique sont des dates. Choisir le pas.
17.11.11  18.11.11  
17.11.11  17.12.11 
17.11.11  17.11.12

4.3.serie alphanumerique 
Les valeurs d’une série alphanumérique sont constituées d’un texte fixe et d’un nombre qui peut être 
incrémenté. Dans l’incrémentation, le tableur ne prend en compte que le nombre entier situé le plus à 
droite. Choisir le pas.
xxx1   xxx2
xxx1  xxx10

4.4.serie créée a partir d’une liste personnalisée
Outils / Options / Calc / Listes de tri 

• Nouveau- introduire lignes dans la fenêtre Entrées
• Copier (la plage sélectionnée en avance) 

blonde brune rousse

Supprimer une liste.
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5. Fixer les lignes et colonnes
Sélectionnez la cellule sous les lignes et à droite des colonnes que vous voulez garder visibles 
lors du défilement. Sélectionnez Fenêtre →  Fixer

6. Indépendance ou dépendance 
Une formule est indépendante lorsqu’elle n’utilise pas la valeur d’une autre cellule (exemple = 8 * 5 - 
6). 
Dans le cas contraire, on dit qu’elle est dépendante (exemple = A3 + B1). On intègre communément des 
contenus de cellules dans les formules. 

7. Opérateurs de calcul 
Pour élaborer une formule de calcul, on se sert d’opérateurs. 
Les opérateurs de calcul sont, par ordre de priorité : 

• puissance ^ (exemple =3^2) ; 
• multiplication * et division / ; 
• addition + et soustraction - . 

Exemple : la saisie =3^2*4+1 affiche comme résultat 37 (est calculé d’abord 3^2, puis 9*4, puis 36+1).
On peut utiliser des parenthèses pour préciser la priorité des calculs. Le nombre de parenthèses 
ouvrantes doit être égal au nombre de parenthèses fermantes. 
La formule de l’exemple précédent peut également être écrite =((3^2)*4)+1. 

8. Opérateurs de comparaison
Ces opérateurs renvoient la valeur logique VRAI ou FAUX.

Opérateur Nom Exemple

= (signe égal) Égal A1=B1

> (Supérieur à) Supérieur à A1>B1

< (Inférieur à) Inférieur à A1<B1

>= (Supérieur ou égal à) Supérieur ou égal à A1>=B1

<= (Inférieur ou égal à) Inférieur ou égal à A1<=B1

<> (Différent de) Inégalité A1<>B1
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9. Opérateur alphanumérique 
L’esperluette & est l’opérateur permettant de concaténer des chaînes de caractères. 
Exemple : saisissez Julie dans A1, Quiberon dans B1, puis dans la cellule C1 la formule suivante : 
=A1&« habite à »&C1. La cellule C1 affiche : Julie habite à Quiberon. Ne pas oublier le signe égal, il 
s’agit d’une formule. 

Afficher ou cacher les formules  - Otils => Options => Calc => Afficher => Formules

10. Opérateurs de référence ( relient des plages de 
cellules)

 

Symboles Noms symboles Opérateurs Exemples

: deux points plage A1:D5

! point d'exclamation (remplacé par un 
espace sous Excel) intersection SOMME(A1:B5!

B3:C10)

; point virgule union SOMME(A1:A10; 
C3:D7)

 

11. Références relatives ou absolues 
Dans une formule, on peut désigner une cellule soit par sa référence ColonneLigne (exemple : = 6*J43),
soit par son nom (pour l'Attribution d’un nom nous allons parler plus tard) 

11.1. Insertion d’une référence 
Il existe deux méthodes pour saisir la référence d’une cellule dans une formule : 

• soit on la saisit avec le clavier : on tape la lettre de colonne suivi du n° de ligne ; 
• soit on la sélectionne avec la souris, méthode particulièrement intéressante quand il s’agit de 

sélectionner des plages de cellules.

11.2. Références relatives, absolues et mixtes 
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11.2.1. Référence relative 

Comme son nom l’indique, elle est relative. Une formule faisant appel à une cellule avec sa 
référence relative, mémorise la position de cette cellule par rapport à celle dans laquelle la 
formule est saisie. 
On se sert fréquemment des références relatives en effectuant la copie d’une formule sur plusieurs 
cellules d’affilée : 
Recopie verticale  - Exemple
Recopie horizontale - Exemple

11.2.2. Référence absolue 

Quand la référence à une cellule est absolue, il convient de le préciser sous la forme : $colonne$ligne 
(procédé mémo : la référence au dollar est absolue…). Dans ce cas, même si la cellule est recopiée, la 
valeur reste celle de la cellule d’origine. Le symbole $ fige la colonne ou la ligne qui le suit
Exemple – achat avec TVA

11.2.3. Référence mixte 

Il est possible d’indiquer une colonne fixe ($ColonneLigne) et une ligne relative, ou vice versa 
(Colonne$Ligne). Exemples : $A8 et A$8. 
Exemple – tableau avec différentes sommes et taux d'intéret

11.2.4. Référence d’une cellule appartenant à une autre feuille 
du même classeur 

Exemple 
Prenons le cas d’un classeur à trois feuilles : Feuille1, Feuille2 et Feuille3 
Sur Feuille2 ou Feuille3, pour faire appel à la cellule T9 de la Feuille1, on écrit : =Feuille1.T9 
On saisit le nom de la feuille, suivie d’un point, suivi de la référence de la cellule. 
Si le nom de la feuille contient un espace, il doit être entouré d’apostrophes. 
Exemple : =‘Feuille une’.T9 

12. Attribution d'un nom
1) Vous pouvez nommer des cellules individuellement. Cette possibilité va permettre de faire des 
formules du type :
=SOMME(Montant_HT:TVA) en lieu et place de =SOMME(A1:A2)

2) Vous pouvez nommer des cellules sélectionnées par plage. Cette possibilité va permettre de faire des
formules du type :
=SOMME(Plage_1;Plage_2) en lieu et place de =SOMME(A1:A10;B1:B10)

3) Vous pouvez nommer des formules. Cette possibilité va vous permettre d'affecter un nom à une 
formule complexe, évitant ainsi plusieurs saisies fastidieuses.  
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12.1. Règles concernant le nom :
• Il doit être différent d’une référence ligne colonne ;
• Le premier caractère doit être une lettre ou le caractère de soulignement ;
• Ne pas utiliser d’espace. Le point et le caractère de soulignement peuvent le remplacer ;
• Se rappeler que le tableur ne fait pas la différence entre majuscules et minuscules, afin d’éviter 

d’appeler deux cellules par le même nom.

12.2. Nommer des cellules individuellement
Appeler le menu Insertion > Noms > Définir (ou Ctrl + F3).
Définition du nom pour la cellule directement dans la zone de nom.

12.3. Nommer des plages
La procédure est identique, il suffit de sélectionner la plage au préalable. Observez que chaque 
cellule conserve son nom d'origine par défaut, seule la plage est nommée.

12.4. Nommer des lignes et colons - 
La procédure est identique, il suffit de sélectionner des lignes ou des colons au préalable

12.5. Nommer des formules
Appeler le menu Insertion > Noms > Définir (ou Ctrl + F3).
Définition du nom dans la zone de nom.
Copiez – Collez la formule dans la zone "Assigné à:".

12.6. Atteindre une cellule ou bien une plage nommée
en utilisant la liste déroulante de zone de nom

12.7. Insérer les noms dans la formule
Pour cela, en cours de saisie de formule, ouvrez le menu Insertion > Nom > Insérer.
Ou bien tapez directement le nom dans la formule.

12.8. Créer des noms automatiquement
Il est possible de créer automatiquement les noms de vos cellules en se servant de leurs
contenus.
Pour cela, sélectionner un tableau, y compris les entêtes de lignes et de colonnes, puis
appelez le menu Insertion > Noms > Créer.
Pour le tableau suivant, nous allons donc créer les noms selon la ligne supérieure et la
colonne de gauche :

Tableurs - fonctions avancées Page 9 sur 27



12.9. Modifier un nom
Le nom « Noms » de l'image précédente fait, lui, référence à B2:F4, vous allez plutôt affecter
A2:A4.

References: https://www.openoffice.org/fr/Documentation/Calc/Tout_sur_les_noms.pdf
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13. Erreurs
Malheureusement, il serait miraculeux que vous ne rencontriez jamais de message d'erreur à la suite de 
la saisie d'une formule. Les messages d'erreur affichés dans les cellules du tableur dépendent du logiciel 
employé.

13.1. erreur #####
La valeur numérique entrée dans une cellule est trop large pour être affichée dans la cellule. Vous 
pouvez augmenter la largeur de la colonne en faisant glisser le bord situé entre les en-têtes de colonnes 
ou en modifiant le format numérique de la cellule.

13.2. erreur #VALEUR!
L'erreur #VALEUR! apparaît essentiellement en cas d'emploi d'un type d'argument ou d'opérande 
inapproprié, ou s'il est indiqué une plage à un opérateur ou une fonction qui exige une valeur unique et 
non une plage. Transformez la plage en valeur unique. Modifiez la plage pour y inclure soit la même 
ligne soit la même colonne contenant la formule. 

13.3. erreur #DIV/0!
Cette erreur apparaît lorsqu'une formule effectue une division par zéro. Cela est souvent dû à une 
référence de cellule vers une cellule vide ou une cellule contenant 0 comme diviseur ou à la saisie d'une 
formule contenant une division par 0 explicite, par exemple =5/0. 

13.4. erreur #NOM?
L'erreur #NOM? apparaît lorsque le tableur ne reconnaît pas le texte dans une formule. Cela peut être dû
à la suppression d'un nom utilisé dans la formule, ou à l'utilisation d'un nom qui n'existe pas, mais le 
plus fréquent est une mauvaise orthographe du nom, par exemple celui d'une fonction.
Autre cause fréquente, l'entrée de texte dans une formule sans l'encadrer par des guillemets anglais 
doubles (il est alors interprété comme un nom) ou l'omission des deux-points (:) dans la référence à une 
plage. 

13.5. erreur #N/A 
L'erreur #N/A apparaît lorsqu'une valeur n'est pas disponible habituellement dans une fonction de 
recherche. 

13.6. erreur #REF!
La valeur d'erreur #REF! apparaît lorsqu'une référence de cellule n'est pas valide. Cela peut être dû à 
leur suppression ou à un déplacement. 

Dans Calc chaque erreur possède un code . Codes
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13.7. Audit de formules : ctrl+F8,   

13.8. Afficher les formules : – 
Outils → Options → Afficher → Formules

14. LES FONCTIONS 
plus de 300 fonctions, utilisables dans les formules. 
Si la fonction est en début de formule, elle doit être précédée du signe égal. 
Exemple : la formule =MAINTENANT() renvoie la date et l’heure courantes. Élargissez la colonne 
si elle est trop étroite (s’il y a affichage de dièses). 

En cours de saisie, elle peut être juxtaposée à un texte grâce à l’esperluette &. 
Exemple 
Sélectionnez la plage B2:C6. Saisissez un nombre dans chaque cellule, validez après chaque saisie en
appuyant sur Tab. 
Dans la cellule D2, écrivez la formule =«Le résultat est » &SOMME(B2:C2). 
Les références étant relatives dans cet exemple, on peut recopier la formule par cliqué-glissé 
jusqu’en D6 (ou plus rapidement en double-cliquant sur la poignée). 

14.1. ARGUMENTS 
Sauf quelques rares exceptions, une fonction requièrent des données, appelées arguments, pour retourner
un résultat. 
Les arguments sont mis entre parenthèses. On place des parenthèses même en l’absence d’argument, 
afin d’indiquer qu’il s’agit d’une fonction. 
Quand il y a plusieurs arguments, ils doivent être séparés par un point-virgule. 

14.1.1.  Exemples de formules utilisant des fonctions qui ont divers nombres et types 
d’arguments 

14.1.1.1.  Fonction sans argument 

La formule =AUJOURDHUI() renvoie la date courante. 
La formule =ALEA() renvoie une valeur aléatoire, qui n’est jamais la même, entre 0 et 1. 
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14.1.1.2.  Fonctions avec un argument 

La formule =ENT(SOMME(E6:G8)) renvoie la partie entière de la somme des valeurs de la plage 
E6 :G8. 

14.1.1.3.  Fonction avec deux arguments 

La formule =DROITE($H$6;4) renvoie les 4 derniers caractères du texte contenu dans la cellule H6. 
La référence étant absolue, le texte de référence restera le même, quelle que soit la cellule d’écriture de 
la formule. 

14.1.1.4.  Fonction avec plusieurs arguments 

La formule =SOMME(5;B1:B6;C3;stupide) renvoie la somme de la constante 5, des valeurs de la 
plage B1:B6, de la valeur de la cellule C3 et de la valeur des cellules de l’ensemble nommé stupide. 
La fonction SOMME peut recevoir de 1 à 30 arguments. 

Comme ces exemples l’illustrent, un argument peut être une constante, la référence d’une cellule, 
les références d’une plage, un nom attribué ou une autre fonction. 

14.2. RECHERCHE ET INSERTION D’UNE FONCTION 
Pour utiliser une fonction dans une formule, deux cas se présentent : 

• soit, bien que sachant ce que vous voulez faire, vous ignorez le nom de la fonction. - 
assistent fonction fx

• soit vous connaissez le nom de la fonction. Vous pouvez alors directement le saisir.  
Juste après la saisie de la première parenthèse ouvrante, une info-bulle affiche le nom de la 
fonction et les arguments requis.  En cliquant sur fx  assistent fonction  apparaisse.  L’insertion 
des arguments peut être effectuée soit par saisie, soit par sélection de cellules. Fermez la 
parenthèse, puis validez. Le résultat de la fonction s’affiche dans la cellule. 

14.3. EXEMPLES 

14.3.1. Bouton somme automatique Σ  

Vous avez une série des cellules (horizontal ou bien verticale) qui contient  des nombres. 
Sélectionnez la cellule à coté qui contiendra le résultat. En cliquant sur le bouton Σ de la barre d’outils 
Standard, 
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on obtient rapidement la somme de cellules sélectionnées. 

Avant de valider, on peut modifier avec la souris la plage des cellules qui participent dans la formule.

14.3.2. La fonction SI 

14.3.2.1. Définition 

Une formule contenant la fonction SI est appelée une formule conditionnelle. Cette fonction est très 
utilisée.  
La fonction SI renvoie un résultat qui diffère selon qu’une expression, appelée « Test », est vraie ou 
fausse (expression dite logique) : 

SI (Test; alors Résultat_si_Test_vrai;  sinon Résultat_si_Test_faux) 

14.3.2.2. L’expression Test

L’expression Test contient nécessairement un opérateur de comparaison : 
égal = 
supérieur >  
supérieur ou égal >= 
inférieur <  
inférieur ou égal <= 
different <>

Remarque: pour tester si une cellule est vide ou faire afficher du vide il suffit d'utiliser "" (deux 
guillemets doubles sans espaces dedans)
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14.3.2.3. Les résultats

Les deux résultats  peuvent contenir des fonctions, des calculs, différents types d’expression (Date, 
Texte, Pourcentage…) etc. 

14.3.2.4. SI avec deux arguments

La fonction SI peut n’être dotée que de deux arguments. 
Exemple : la formule =SI(E6=«Jaune»;«la couleur est jaune») affiche FAUX si la valeur de E6 n’est 
pas le mot Jaune. 

14.3.3. Fonctions logiques 

Les arguments et les résultats sont de type logique – VRAI   ou FAUX. Utilisés pour tester des 
conditions dans la fonction SI()

Fonctions Syntaxe Exemples Résultats Commentaires

ET
(AND)

=ET (valeur 
logique1; 
valeur 
logique2; ...; 
valeur 
logique30)

=ET (10>2; 
50>25)

VRAI
Permet de tester jusqu'à 30 
conditions. Retourne VRAI si 
toutes les conditions sont VRAI et 
FAUX dans les autres cas.

=ET(10>2; 
50>25; 10+1=11)

VRAI

=ET(10>2; 
50=25)

FAUX

VRAI
(TRUE)

Valeur logique appliquée. Retourne
toujours la valeur logique VRAI.

FAUX
(FALSE)

   
Valeur logique appliquée. Retourne
toujours la valeur logique FAUX.

NON
(NOT)

=NON (valeur 
logique)

=NON(1=2) VRAI

Inverse une valeur logique.=NON(1) FAUX

=NON(FAUX) VRAI

OU
(OR)

=OU (valeur 
logique1; 
valeur 
logique2; ...; 
valeur 
logique30)

=OU(10>5;20>14) VRAI

Retourne la valeur VRAI si un 
argument est VRAI et FAUX si 
tous les arguments sont FAUX. 30 
cas maxi.

=OU(10<3;5<2) FAUX

=OU(10>3;5>2) VRAI

=OU(2=2; 40>10; 
30<60; "A"<"B";
10*2=20)

VRAI

OUX
(XOR)

=OUX (valeur 
logique1; 
valeur 
logique2; ...; 
valeur 
logique30)

=OUX(VRAI;VR
AI)

FAUX

Renvoie true si un nombre impair 
d'arguments est évalué à VRAI.

=OUX(VRAI;VR
AI;VRAI)

VRAI

=OUX(FAUX;VR
AI)

VRAI

Une fonction peut en imbriquer d’autres, sept niveaux sont possibles. 

Donnez une remise si la somme dépensée est entre deux valeurs.

Tableurs - fonctions avancées Page 15 sur 27



14.3.4. Autres exemples 

OO_Calc_Formules_et_Fonctions    =»  4.2. Quelques fonctions statistiques

14.3.4.1. Exercice 1 - 

Nom
Brut hors 
taxes

Remise
Montant 
remise

Net hors 
taxes

BLAISE 11720   
APOLIN 8440   
RAYLU 13602   
FERMAR 9704   
VALEZI 18035   

Télécharger ce fichier
Accorder une remise de 2 % pour les clients dont le hors 
taxes
dépasse 10000 Euros.

14.3.4.2. Exercice 2 

Télécharger ce fichier
Une entreprise souhaite verser une prime de 1000 € de fin d'année à ses représentants 
s'ils remplissent l'une OU l'autre des conditions suivantes :

·         Avoir plus de 5 ans d'ancienneté
·         Avoir réalisé plus d' 1 Million d'euros de chiffre d'affaires. 
Les représentants sont répertoriés dans le tableau suivant :

 
Nom du 
Représentant

Années
d'ancienneté

Chiffre 
d'affaires

Prime

2 ARMAND 3  1 213 000 € 
3 FLORA 6     997 000 € 
4 NINIAN 7  1 016 000 € 
5 SEBATI 1     757 000 € 

Vous pouvez voir plus d'exemple à   http://user.services.openoffice.org/fr/forum/viewtopic.php?
t=358
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14.4. DATE ET HEURE 

14.4.1. Date 

Le tableur (Calc ou Excel) enregistre une date sous la forme d’un nombre, appelé « numéro de série », 
calculé à partir du 1er janvier 1900. Par exemple, le 12/09/2008 correspond au numéro de série 39703, ce
qui signifie que 39703 jours se sont écoulés depuis le 1er janvier 1900. 

14.4.2. Heure 

Calc (et Excel) enregistre une heure sous forme de fraction décimale. 
Exemples : l’heure 12:00 correspond à 12/24, soit 0,5. L’heure 18:00 correspond à 18/24 soit 0,75. 
L’heure 24:00 est le maximum, cette heure correspond à 24/24, soit 1. 

La transformation d’une date ou d’une heure en nombre, permet d’effectuer des calculs avec des 
données de ce format. 

14.5. Fonction JOURSEM

JOURSEM  Renvoie le jour de la semaine d'une date donnée. 

JOURSEM(date; type) 

renvoie le jour de la semaine dont date fait partie, comme un nombre. 
Le nombre renvoyé dépend du type, comme ci-dessous: 

jour de la semaine type=1 type=2 type=3 

Dimanche 1 7 6 

Lundi 2 1 0 

Mardi 3 2 1 

Mercredi 4 3 2 

Jeudi 5 4 3 

Vendredi 6 5 4 

Samedi 7 6 5 

si type est omis, il est supposé correspondre à 1. 

14.6.  AUJOURDHUI()
Détermine la date courante de l'ordinateur.

14.7. ESTBISSEXTILE(date)
Renvoie 1si l'année d'une date est bissextile si non  0 
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JOURS(date initiale; date fin)
Renvoie le nombre des jours entre deux dates

NB.JOURS.OUVRES(date initiale; date fin;plage avec les fêtes)
Renvoie le nombre des jours ouvrés compris entre deux dates

15. Listes déroulantes et fonctions de 
recherche 

15.1. Etapes
 3 étapes : Faire un tableau de données, créer une liste déroulante et enfin afficher un résultat 
différent en fonction de l'entrée dans la liste.

15.2. Tableau de données
Nous allons donc commencer par saisir les données : ici j'ai écris des chiffres en lettre dans 
une première colonne, et dans un seconde j'ai entré l'équivalent en chiffres. 

15.3. Liste deroulante
Voilà, le terrain est préparé, nous allons maintenant créer la liste on se met dans la case où 
l'on aimerai voir apparaitre la liste puis on se rend dans le menu données -> validités puis on 
sélectionne Plage de cellules et on entre la plage ce cellules qui contiennent les données (ici on 
écris le numéro de la case correspondant à Un : (deux points) celle correspondant à 5)
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15.4. Fonctions de recherche 
Nous allons maintenant créer la cellule contenant le résultat en créant les correspondances 
entre la valeur sélectionnée dans la liste (ici les chiffres en lettre) et les valeurs 
correspondantes (les chiffres en... chiffres). Cliquez donc sur l'assistant de fonction :

 

Dans la liste de gauche sélectionnez la fonction RECHERCHEV qui fait une recherche 
verticale. C'est-à-dire qu'elle fait correspondre une valeur à sa correspondance directement à 
droite ou à gauche.
Dans Critère de recherche sélectionnez la case qui contient la liste.
Dans matrice sélectionnez la plage de donnée (la zone qui contient nos chiffres et nos lettres, 
ou tapez la même chose que tout à l'heure lors de la création de la liste).
Dans Indice tapez l'indice de la colonne contenant les résultats (ici les chiffres en chiffres). 
Attention, il s'agit du numéro de la colonne depuis le début de la plage de cellules en 
commençant par 1. C'est-à-dire si votre plage de cellule et entre le colonne C et D avec les 
résultats dans D vous taperez 2 (la deuxième colonne en partant de C). 
Dans ordre de tri il faut mettre 0 si l'information dans la plage n'est pas triée et 1 (ou vide) si 
elle est triée.
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Voilà c'est fait vous avez une liste déroulante, qui fait varier le contenu d'une cellule en 
fonction de sa valeur. Maintenant vous pouvez cacher les lignes contenant les valeurs pour 
faire plus propre.

16. Protéger un document ou une feuille

    La protection du document permet d'éviter toute modification de sa structure, par exemple 
l'ordre, le nombre et le nom des feuilles. Mais vous pouvez toujours éditer ce document.

    La protection d'une feuille permet d'empêcher toute modification du contenu et du format 
de toutes les cellules de la feuille.

    Si vous allez dans le menu Format puis Cellules…, et si vous cliquez sur l'onglet Protection, 
vous constaterez que la case Verrouiller de la section Protection est cochée par défaut. Si vous 
voulez protéger un document ou une feuille, ne changez rien.

        Pour protéger le document, allez dans le menu Outils, choisissez Protection et 
Document….

        Pour activer la protection d'une feuille, allez dans le menu Outils, choisissez Protection et 
Feuille…. 
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16.1. Protéger des cellules individuelles
    Sélectionnez l'ensemble de la feuille contenant les cellules que vous voulez protéger en 
pressant les touches Ctrl-A.

    Allez dans le menu Format puis cliquez sur Cellules….

    Dans l'onglet Protection de la fenêtre Formatage des cellules, décochez la case Verrouiller.

    Cliquez sur OK.

    Revenez dans la feuille contenant les cellules que vous voulez protéger, sélectionnez ces 
cellules. Il n'est pas nécessaire qu'elles soient adjacentes.

    Allez dans le menu Outils, choisissez le sous-menu Protection et cliquez sur Feuille….

    Entrez un mot de passe et confirmez-le. Cliquez sur OK.

    Allez dans le menu Format puis cliquez sur Cellules….

    Dans l'onglet Protection de la fenêtre Formatage des cellules, cochez la case Verrouiller.

        Note : vous pouvez protéger à la fois le document et des feuilles ou le document et des 
cellules individuelles. 

16.2.  Désactivation de la protection du document ou de 
cellules

    Pour désactiver la protection du document, allez dans le menu Outils puis dans le sous-
menu Protection et décochez l'article Document….

    Pour désactiver la protection d'une feuille ou de cellules individuelles dans une feuille, 
placez-vous dans la feuille qui les contient, allez dans le menu Outils puis dans le sous-menu 
Protection, et décochez l'article Feuille…. 

17. Exemple – Facture
Télécharger ce fichier

18. LES FORMULES MATRICIELLES 

Une formule matricielle est, comme son nom l’indique, une formule contenant une matrice, c’est-à-dire 
une plage de cellules, utilisée dans un calcul. 

L’utilisation d’une formule matricielle permet d’éviter des copies de formule.  Elle préserve 
également la plage de cellules contenant la formule 
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18.1. PROCEDURE 
La procédure comprend trois étapes : 
1. Sélectionnez la plage de cellules résultats, c’est-à-dire la plage des cellules qui contiendront chacune 
la formule matricielle ; 
2. Cliquez dans la barre de formule et saisissez la formule matricielle ; 
3. Validez par Ctrl + Maj + Entrée (cette validation permet d’indiquer qu’il s’agit d’une formule 
matricielle). La formule apparaît alors entre accolades dans la barre de formule. 

18.2. EXEMPLES 
1. Calcul du Prix HT 
2. Calcul du Prix TTC 
3. Table de multiplications 

18.3. CONTRAINTES PARTICULIERES 

18.3.1. Insertion, suppression ou déplacement 

Il n’est pas possible d’insérer, de supprimer ou de déplacer une cellule appartenant à une plage 
contenant une formule matricielle. Cela permet de préserver la plage contenant cette formule. 

18.3.2. Modification d’une formule matricielle 

1. Sélectionnez la plage de cellules contenant la formule matricielle. Il y a plusieurs méthodes : 
- sélectionnez par cliqué-glissé, 
- ou bien : sélectionnez une cellule de la plage, puis appuyez sur Ctrl + / 

2. Cliquez dans la barre de formule et effectuez les modifications nécessaires ; 
3. Validez par Ctrl + Maj + Entrée. 

18.3.3. Effacement d’une formule matricielle 

Sélectionnez la plage de cellules résultats, comme précédemment ; puis appuyez sur la touche Suppr 

19. Diagrammes 

Exemple-  x, sin(x)  cos(x)

Fichier exemple

https://wiki.documentfoundation.org/images/f/fa/CG3503FR-Diagrammes.pdf
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20. Masquer et afficher les lignes et les 
colonnes

Masquer – sélectionner les lignes (colonnes) – bouton droite – masquer

Afficher - sélectionner les 2 lignes (colonnes) – bouton droite – afficher

21. Trier des cellules

Vous avez la possibilité de trier les cellules selon vos besoins.

Par exemple la colonne A par ordre décroissant.

Il vous faudra sélectionner l'ensemble de la plage à trier :

Aller dans le menu : Données / Trier :

En dessous de "Trier selon" : choisir "colonne A" et cochez la case "Décroissant"
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Ce qui donne le résultat suivant :

Et voilà  vos cellules sont triées.

22. Filtres
Les filtres s’utilisent avec une table de données. 

Ils permettent de sélectionner des enregistrements selon certains critères ou certaines 
conditions. 

Trois types de filtres sont disponibles :

 l’AutoFiltre, 
 le Filtre standard..., 
 Le Filtre spécial....

Chacun d’entre eux est accessible par le menu Données / Filtre. 

22.1. L’AutoFiltre
est le plus simple.

En le sélectionnant, vous obtenez un menu déroulant pour chaque étiquette de colonne.

Tableurs - fonctions avancées Page 24 sur 27



 Le menu déroulant regroupe, sans doublons, tous les termes, ou toutes les valeurs, contenus 
dans le champ. 
 Il contient également des fonctions de filtre comme :

• “le Top10” qui permet d’afficher les 10 derniers enregistrements de la base,
• l’accès au Filtre standard...,

22.2. Le Filtre standard...
est plus élaboré... et, d’ailleurs, utilise des  opérateurs relationnels

 Les opérateurs relationnels sont des opérateurs qui permettent de définir des conditions : 

= égal 
> supérieur à 
< inférieur à 
=> supérieur ou égal à 
=< inférieur ou égal à 
<> différent de 
Le plus grand le plus grand nombre 
Le plus petit le plus petit nombre 
Le plus grand % le plus grand nombre en % 
Le plus petit % le plus petit nombre en % 
Contient contient telle valeur ou tel mot ou telle expression 
Ne contient pas ne contient pas telle valeur ou tel mot ou telle expression 
Commence par commence par telle valeur ou tel mot ou telle expression 
Ne Commence pas par ne commence pas par telle valeur ou tel mot ou telle expression
 Finis par se termine par telle valeur ou tel mot ou telle expression 
Ne finis pas par ne se termine pas par telle valeur ou tel mot ou telle expression

23. Insertion d'un tableau de Calc dans 
writer

Sélectionnez la plage des cellules qui contienne le tableau
Dans writer – Édition - » Collage spécial (ou bien CTRL+MAJ+V) - »lien DDE
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24. SIMULATIONS 

24.1. FONCTION « VALEUR CIBLE »  

Elle permet de connaître quelle doit être la valeur contenue dans une cellule pour atteindre une valeur 
définie dans une autre cellule. 

Exemple : 

quel doit être le prix de vente d’un produit (contenu dans la cellule à modifier) pour obtenir un bénéfice
donné (valeur cible, contenue dans la cellule à définir). 

Autrement dit, en utilisant les expressions de la fenêtre « Valeur cible », la fonction « Valeur cible » 
indique, en fonction de la « valeur cible » contenue dans la « cellule à définir », quelle doit être la valeur
de la « cellule à modifier ». 

La cellule à modifier ne doit pas contenir de formule, juste une valeur. 

La cellule à définir contient une formule dépendant, directement ou indirectement, de la valeur de la 
cellule à modifier. 
 Exemple [http://www.coursbardon-microsoftoffice.fr/coursexcel2010.pdf]

Vous êtes artiste peintre. Vous vendez vos toiles à un prix moyen de 400 €. 

Vous aimeriez connaître le nombre minimum de toiles que vous devez vendre par mois pour gagner 
2000 € / mois. 

Vos frais s’élèvent à 80 € en moyenne par tableau, et vous louez un atelier 150 € / mois, charges 
comprises. 

Modélisez ces données sur une feuille de calcul : 

Menu Outils/Recherche de valeur cible
Indiquez :
• cellule de formule = cellule contenant la fonction qui calcule le résultat recherché
• Valeur cible = saisir le montant а obtenir
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Prix moyenne d'une toile 400,00 €
Nombre de toiles 0
Recette de la vente 0,00 € =prix moyenne *nombre
Frais moyenne d'une toile 80,00 €
Total frais moyens 0,00 € =frais moyenne *nombre
Location de l'ateleier 150,00 €
Bénéfice -150,00 € =Recette-frais-location



• Cellule variable = cellule utilisée dans le calcul de la fonction а faire varier. Ici, nous
demandons de modifier le nombre des tableaux vendus.
Validez par OK
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